syngo MR D13
Operator Manual - Breast
syngo MR D13

www.siemens.com/healthcare
Manufacturer’s notes:
This product bears a CE marking in accordance with the provisions of regulation 93/42/EEC of June 14, 1993 for medical products. The CE marking applies only to medico-technical products/medical products introduced in connection with the above-mentioned comprehensive EC regulation.
Overview of Contents

Measurements

Post-processing

Index
A Measurements
  A.1 Diffusion-weighted measurements
  A.2 1H MR Spectroscopy of the breast with syngo GRACE
  A.3 Prosthetic silicone implants
  A.4 Breast Dot Engine

B Post-processing
  B.1 Spectroscopy evaluation

C Index
Introduction

In order to operate the MR system accurately and safely, the operating personnel must have the necessary expertise as well as knowledge of the complete operator manual. The operator manual must be read carefully prior to using the MR system.

Layout of the operator manual

Your complete operator manual is split up into several volumes to improve readability. Each of these individual operator manuals covers a specific topic.

- Hardware components (system, coils, etc.)
- Software (measurement, evaluation, etc.)

Another element of the complete operator manual is the information provided for the system owner of the MR system.

The extent of the respective operator manual depends on the system configuration used and may vary.

All components of the complete operator manual may include safety information that needs to be adhered to.

The operator manuals for hardware and software address the authorized user. Basic knowledge in operating PCs and software is a prerequisite.
The current operator manual

This manual may include descriptions covering standard as well as optional hardware and software. Contact your Siemens Sales Organization with respect to the hardware and software available for your system. The description of an option does not infer a legal requirement to provide it.

The graphics, figures, and medical images used in this operator manual are examples only. The actual display and design of these may be slightly different on your system.

Male and female patients are referred to as “the patient” for the sake of simplicity.

References to “Siemens Service” include service personnel authorized by Siemens.

Configuration

This manual consists of multiple parts (Part A, Part B, etc.). A comprehensive Table of Contents can be found at the beginning of each part.
**Important icons**

For readability, certain contents are highlighted. In the following sections, you will find the symbols and their contents used:

- ✓ Prerequisites for the operating steps to follow
- ◆ Request for action
- ■ Item in list

<table>
<thead>
<tr>
<th>!</th>
<th>Notes for optimal use of the MR system.</th>
</tr>
</thead>
<tbody>
<tr>
<td>i</td>
<td>Remarks that facilitate work with the system.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>?!</th>
<th>Problem</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Description of possible source of errors</td>
</tr>
<tr>
<td></td>
<td>◆ Requests for action to solve problems</td>
</tr>
</tbody>
</table>
**Intended use**

Your MAGNETOM MR system is indicated for use as a magnetic resonance diagnostic device (MRDD) that produces transverse, sagittal, coronal and oblique cross sectional images, spectroscopic images and/or spectra, and that displays the internal structure and/or function of the head, body, or extremities. Other physical parameters derived from the images and/or spectra may also be produced. Depending on the region of interest, contrast agents may be used. These images and/or spectra and the physical parameters derived from the images and/or spectra when interpreted by a trained physician yield information that may assist in diagnosis.

Your MAGNETOM MR system may also be used for imaging during interventional procedures when performed with MR compatible devices such as in-room displays and MR-safe biopsy needles.

!! The MAGNETOM MR system is not a device with measuring function as defined in the Medical Device Directive (MDD). Quantitative measured values obtained are for informational purposes and cannot be used as the only basis for diagnosis.

!! For the USA only: Federal law restricts this device to sale, distribution and use by or on the order of a physician.
**Authorized operating personnel**

The MAGNETOM MR system must be operated according to the intended use and only by qualified persons with the necessary knowledge in accordance with country-specific regulations, e.g. physicians, trained radiological technicians or technologists, subsequent to the necessary user training.

This user training must include basics in MR technology as well as safe handling of MR systems. The user must be familiar with potential hazard and safety guidelines the same way the user is familiar with emergency and rescue scenarios. In addition, the user has to have read and understood the contents of the operator manual.
A.1  Diffusion-weighted measurements  A.1-1
   General information      A.1-1
   Determining the ADC value (optional)  A.1-2
      Measuring diffusion-weighted images A.1-2
   Evaluating the ADC map   A.1-4

A.2  1H MR Spectroscopy of the breast with syngo GRACE  A.2-1
   General information      A.2-1
   Applications           A.2-1
   Quantification         A.2-2
   Quantifying the total choline in breast tumors A.2-3
   Reformattign reference images A.2-3
   Planning the VOI       A.2-4
   Suppressing interference signals A.2-7
   Starting protocol adjustments (optional) A.2-9
   Shimming interactively (optional) A.2-11
   Improving shim results (optional) A.2-14
   Adjusting the frequency (optional) A.2-15
   Measuring raw data     A.2-17
   Measuring the external reference A.2-19
A.3  Prosthetic silicone implants  A.3-1
General information  A.3-1
Spectral differences  A.3-1
Types of visualization  A.3-3
Helpful information from the patient  A.3-4
Displaying pure silicone images (optional)  A.3-5
Suppressing the fat signal  A.3-6
Suppressing the water signal  A.3-10

A.4  Breast Dot Engine  A.4-1
Planning the examination and measuring the localizer  A.4-2
Adapting the examination to the patient  A.4-2
Starting the measurement of the localizer  A.4-5
Defining the breast implant situation  A.4-5
Confirming the resonance frequency  A.4-6
Selecting the type and location of implants  A.4-7
Allocating the silicone peak  A.4-8
Imaging the morphology  A.4-9
3D Examinations with integrated MPR planning  A.4-10
Subsequent measurements  A.4-12
Measuring diffusion-weighted images  A.4-12
Measuring pure silicone images (optional)  A.4-13
Displaying the biopsy coordinates  A.4-14
Configuring program steps (optional)  A.4-17
Assigning 3D measurements to the integrated MPR post-processing  A.4-18
Adding MPR views  A.4-20
Configuring the biopsy support  A.4-23
Diffusion-weighted measurements

General information

The specificity of breast MRI can be increased using diffusion-weighted imaging (DWI).

Principle of DWI

DW MRI is based on the principle that random motion of molecules during the interval of excitation and signal measurement reduces the amplitude of the resulting signal. The application of appropriate pulse sequences (using, for example, bipolar gradient pulses in one or several directions) allows you to measure signal cancellation due to diffusion in the given direction. While normal tissue exhibits gross signal loss, areas with restricted molecular motion such as densely packed tumor cells show less signal loss and become bright in diffusion-weighted images.

ADC map

The ADC map (ADC = Apparent Diffusion Coefficient) allows for an in-vivo pseudo quantification of the diffusion effect. Due to the limited mobility of water molecules in the vicinity of a tumor, malignant lesions may show lower ADC values than benign lesions.
Determining the ADC value (optional)

First, you have to locate the lesion in the diffusion-weighted images. As a second step, you determine the ADC value in the corresponding ADC map.

Measuring diffusion-weighted images

✓ Localizer has been measured
✓ High-resolution protocol has been measured
✓ Diffusion-weighted protocol has been opened

Setting the parameters for diffusion weighting

◆ Open the Diff Body parameter card.
Select the diffusion mode 3-Scan Trace. The measurements are performed in three random directions. 3 measurements per image are required.

Select the b-value (e.g. 50, 400, 800) for each diffusion weighting.

Higher b-values extend the TE.

Select Trace-weighted images and Average ADC maps. The number of diffusion directions is automatically set to 3.

Perform the measurement

Start the measurement.

One diffusion-weighted image per slice position and b-value is calculated. The corresponding ADC maps are calculated automatically.
Evaluating the ADC map

- Diffusion-weighted images have been measured
- ADC maps are available
  - Transfer the diffusion-weighted images and the ADC maps to the Viewing task card.
  - Locate the lesion in the diffusion-weighted images and in parallel on a subtracted series.
  - Draw a region of interest (ROI) in the center of the lesion.

A central necrosis should not be enclosed by an ROI. It has a different cellularity and therefore a different ADC value compared to the tumor.

- Copy the ROI to the ADC map.
- Determine the ADC value (mean value of the greyscale values).
1H MR Spectroscopy of the breast with syngo GRACE

General information

The metabolite status in the tumor tissue can be acquired via the total choline (tCho) concentration. The concentration in healthy breast tissue is usually very low. An increased signal of total choline in the spectrum usually correlates with a positive biopsy result.

Please note: At higher field strength, small signals of total choline have also been detected in benign lesions and in normal breast tissue. Total choline levels may also be visible in the lactating breast along with the characteristic lactose signal.

Applications

- Help in the differentiation between tumors
- Monitoring the course of therapy
- Identification of possibly vital residual findings after chemotherapy and preoperative intervention
**Quantification**

To evaluate total choline as a metabolic marker, the metabolite has to be quantified.

**Quantification with an external reference**

A reference solution is present in the breast coil housing for quantifying the signal of total choline. The signal is automatically normalized with an additional measurement of the reference sample water signal.

**Quantification with an internal reference**

The signal of total choline can also be quantified by using an internal reference measurement, that is, in the tumor itself. For this purpose, you can perform a fast, non-water suppressed measurement in the tumor of identical voxel position and size.

*The internal reference method is not considered clinically sound for controlling the course of therapy. For example during chemotherapy, the behavior of internal water in the tumor is largely unknown.*
Quantifying the total choline in breast tumors

Reformatting reference images

- 3D subtraction data set is available
- SVS breast measurement program has been selected

When performing MRS after a routine imaging examination, you can use existing images as reference images to plan the MRS measurement.

To plan spectroscopy and for post-processing you need non-distortion corrected images (ND) in the three main orientations. Spectroscopy measurements must be performed at the same table position as the ND images used for planning.

- Use, for example, thin MIP reconstruction to reformat the 3D subtraction data set into 3 orthogonal planes centered on the lesion.
- Save the new MIP series.
- Load the MIP series as reference images into the image area of the Exam task card.
Planning the VOI

An essential prerequisite for MR spectroscopy is a reliable localization. For MRS of the breast, you use the SVS technique (Single Voxel Spectroscopy) to allocate the spectra signals to the anatomic volume given. During SVS, only a limited volume of interest (VOI) is acquired. A single spectrum is obtained.

✓ SVS breast protocol has been opened
✓ VOI is displayed
◆ Ensure, that the appropriate coil element for the measurement is selected.
Position the voxel so that it contains the tumor only.

Good planning.
Measurements

Poor planning, voxel is too large (fat signal is superimposed on choline signal).

To better adjust the voxel to the lesion, you can position up to 8 saturation slices.


Suppressing interference signals

Suppressing respiratory artifacts  
To minimize artifacts caused by the patient's breathing, you perform an Inline frequency correction.

◆ Open the Sequence parameter card.

◆ Activate the Freq. corr. accumulation checkbox.

The system automatically activates a weak water suppression (Contrast Common parameter card).

Setting weak water suppression  
A weak water suppression leaves a residual water peak. This allows you to include the water line in various post-processing functions.

◆ In the Contrast Common parameter card: Ensure that reduced water suppression has been selected.
Suppressing fat signals

To minimize fat signals, you perform an Inline spectral fat saturation.

- Open the Contrast Common parameter card.
  - Select Lipid suppr. from the Spectral suppr. list.
  - Select the bandwidth of the suppression pulse (Lipid suppr. BW).
  - Select the spectral shift of the suppression pulse (Lipid s. delta pos.).
Starting protocol adjustments (optional)

Semi-automatic adjustments are recommended for difficult anatomical regions (e.g. flow, vessels, jumps in susceptibility). You can check the shim status prior to the spectroscopy measurement and improve it, if necessary.

- Automatic adjustment is not satisfactory
- Select Options > Adjustments from the main menu.

The Manual Adjustments dialog window is opened.

- Select the Show subtask card.
Start the adjustments with **Adjust All**.

All protocol adjustments are performed (as displayed in the information window).
Shimming interactively (optional)

The shim quality is particularly important for spectroscopy examinations. Use interactive shimming for checking and improving the examination. By changing the shim currents you are able to optimize the results (FWHM, T2*).

✔ Protocol adjustment has ended

◆ In the Manual Adjustments dialog window: Select the Interactive Shim subtask card.
Start the shim with **Measure**.

An infinite measurement is performed with the currently set shim parameters.
Monitor the results for FWHM and T2*.

**FWHM [Hz]:** as small as possible
- 1.5 T < 25 Hz
- 3 T < 30 Hz

**T2*: as large as possible. Depends on voxel size and the metabolites contained within.

End the measurement with **Stop** as soon as you are satisfied with the results. (Otherwise: ([Page A.2-14 Improving shim results (optional)]).

---

During visual inspection: If the water is less than twice the fat amplitude, the size and/or position of the voxel should be readjusted.

- Apply the shim results to the following spectroscopy measurement with **Apply**.
- Close the dialog window.
- Start the spectroscopy measurement.
Measurements

Improving shim results (optional)

If the results for FWHM and T2* are not satisfactory, you can improve the homogeneity of the magnetic field by changing the shim currents.

✓ Interactive Shim subtask card has been opened
✓ Shim results are not satisfactory
◆ Change the gradient offset for one shim channel.

Example Channel X

◆ Increase the value with the up arrow button.
◆ Monitor FWHM and T2*.

If the result worsens:

◆ Use the best shim results of the current measurement with Load Best.
◆ Change the gradient offset in the other direction (use the down arrow button).

If the results for FWHM and T2* continue to be unsatisfactory:

◆ Repeat the steps for the other channels (Y, Z).

As soon as you are satisfied with the results:

◆ End the measurement with Stop.
◆ Apply the shim results to the following spectroscopy measurement with Apply.
Adjusting the frequency (optional)

Whenever you change shim currents, a “?” appears in the Frequency (syst) field. This means that the frequency still needs to be adjusted (if not performed manually, the system handles it automatically).

✓ Shim currents have been changed
◆ In the Manual Adjustments dialog window: Select the Frequency subtask card.
Measurements

- Start the frequency adjustment with **Go**.
- Monitor the tolerance parameter "Diff [Hz]".

**Optimal frequency: Diff [Hz] = 0 +/- 2 Hz**
Repeat the adjustment until you obtain a satisfactory value for “Diff [Hz]” and the “Y” in the A. column appears.

Transfer the frequency determined to the measurement system with Close.

You can now begin with the spectroscopy measurement.

**Measuring raw data**

You are starting to generate the spectroscopy raw data. During the measurement, you are able to monitor the raw signal in the Inline Display and control the measurement accordingly.

- VOI has been planned
- Start the measurement.

All adjustments required are performed automatically prior to the measurement. For most applications, the default values of the adjustment configuration that have been currently determined are considered optimal. (Otherwise: (➡ Page A.2-9 Starting protocol adjustments (optional)).)

- To open the Inline Display, select **View > Inline Display** from the main menu.
Measurements

(1) Accumulated magnitude spectrum
(2) Magnitude time signal of the current acquisition
(3) Magnitude spectrum of the current acquisition

After the measurement, the spectroscopy raw data and the reference images are automatically stored to the patient database (as shown by the icons).

Icons for reference images and spectroscopy raw data in the Patient Browser.

Follow-up examinations: Use the Phoenix functionality of the syngo software to recall the same measurement protocol. This ensures that the same parameters are used for all measurements except the voxel size, which may be adjusted to the reduced size of the tumor.
Measuring the external reference

- Open and start the reference localizer (localizer_ref). The localizer is already positioned on the small reference bottle.
- Open the svs_se_breast_ref reference protocol.
- Position the voxel fully within the reference solution.
- Start the SVS reference measurement.

A fast SVS measurement without water suppression is performed.

For a description of measuring the internal reference, please refer to: (➡ Page A.2-2 Quantification).

For a description of evaluating spectra, please refer to: (➡ Page B.1-1 Spectroscopy evaluation).
Prosthetic silicone implants

*General information*

MR imaging of prosthetic silicone implants requires high-resolution images. Depending on the clinical question, either fat or silicone can be suppressed, or pure silicone images can be created.

*Spectral differences*

Spectral differences between fat, silicone, and normal breast parenchyma enable selective signal suppression.
Display of MR spectra: The frequency of spectra (silicone, fat, and water) runs from left to right. Normally, the fat line somewhat overlays the silicone line.

1. Amplitude
2. Frequency
3. Silicone
4. Fat
5. Water

**Fat/silicone suppression**

Fat or silicone suppression may be complete or partial.

**Better orientation:** The contours of the breast and implants may be improved using a partial fat/silicone suppression.
Types of visualization

**Pure silicone images**
To display capsule contractures, prosthesis dislocation, ruptures (intracapsular: “linguini” signs, extracapsular: defect in the fibrous capsule, possibly siliconoma).

**With silicone suppression**
To display fat or tumors.

**With water suppression**
To suppress the signal from cysts (water is displayed dark).
Measurements

With fat suppression

To display water-filled cysts (water is displayed bright).

Helpful information from the patient

- Age and type of implants.
- Whether it is the first implant in the breast.
- Whether prior implants were ruptured.
- Amount of saline solution added and how it was added.
Displaying pure silicone images (optional)

It may be necessary to display silicone implants during breast examinations. In this case, the signals from fat and water have to be suppressed. The result image displays the pure silicone signal.

Sample measurement program

- STIR with water saturation: The fat signal is suppressed by an additional inversion pulse. The water saturation pulse (centered on the water peak) suppresses the signal from the breast and blood vessels. In the result image, silicone is displayed bright.

Spectral water saturation is possible because the frequency separation between water and silicone is greater than that between water and fat. However, silicone may become partially saturated.
T2 sagittal: To check the impermeability of the silicone implant. Displays creases in the implant (e.g. linguini or keyhole signs)

Silicone suppression: With any T1-weighted or T2-weighted measurement using a water saturation pulse (centered on the silicone peak). In the result image, silicone is displayed dark.

**Suppressing the fat signal**

- ✔ Coils element has been selected
- ✔ Localizer has been measured
- ✔ Protocol has been opened
- ✔ Slices have been positioned
Adjusting the resonance frequency

An inline adjustment is performed automatically prior to each measurement. You can pause the system to confirm or change the resonance frequency calculated by the adjustment.

- Open the **System Adjustments** parameter card.

- Activate the **Confirm freq. adjustment** and **Assume Silicone** checkboxes.

- Start the measurement.
The adjustment is performed automatically. The Confirm Frequency Spectrum dialog window is displayed.

For unilateral or small implants: Check the automatic peak detection, because the silicone signal can be very small. For this purpose, view the signals of the individual coil elements. They allow you to check whether the system frequency on the side of the implant is located on the desired peak (e.g. on the water peak, if water is to be saturated to obtain a silicone image).
If you want to accept the requested frequency without changes to it click Apply and Continue.

The measurement is performed without additional adjustments.

Changing the resonance frequency

- Enlarge the frequency spectrum by double-clicking with the right mouse button.
- Center the frequency on the fat peak by clicking the fat peak.

The new transmit frequency is copied to the Frequency (temp) field.

- Add 220 Hz at 1.5 Tesla to this value or 440 Hz at 3 Tesla (the last 3 numbers of the transmit frequency).
- Start the measurement with Apply and Continue.

The measurement is performed without additional adjustments.

With very high fat proportions: Check the automatic peak detection prior to each measurement with spectral fat sat and adjust manually, if necessary.
**Suppressing the water signal**

The water saturation suppresses the peak used for centering the resonance frequency and may be utilized for almost every protocol.

- Coil element has been selected
- Localizer has been measured
- Protocol has been opened
- Slices have been positioned

**Setting the water suppression**

- Open the **Contrast Common** parameter card.
- Set the water suppression to **Water sat.**
Breast Dot Engine

The Breast Dot Engine covers the main use case of breast MRI, which is lesion evaluation. Multiple variants, such as lesion evaluation with or without implants (which can be silicone or saline) are provided.

For improvement of the biopsy workflow, a biopsy support is provided. (➡ Page A.4-14 Displaying the biopsy coordinates)

The Dot Engine user interfaces shown in this operator manual are examples only. The actual guidance texts and the design may be slightly different on your system.

In the following, we are focusing on examinations with the 16-Channel AI Breast Coil.
Planning the examination and measuring the localizer

✓ Patient has been registered
✓ 16-Channel AI Breast Coil has been connected
✓ Coil elements have been selected
✓ Breast Dot Engine has been selected

Adapting the examination to the patient

After registration, the Patient View opens automatically. The default examination parameters are loaded.

In the Patient View you adapt the examination parameters to the patient's need. The pending protocols of the measurement queue are updated upon your selection.
**Auto Coverage**
- Select the **Auto Coverage** checkbox if the FoV calculation and slice positioning should be performed automatically.

**Confirming frequency adjustments**
- Select the settings for the adjustment of the resonance frequency.

<table>
<thead>
<tr>
<th>Confirm freq. adjustment</th>
<th>Activates the corresponding checkbox on the <strong>System Adjustments</strong> parameter card.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Only after frequency change</td>
<td>Activates the corresponding checkbox on the <strong>System Adjustments</strong> parameter card.</td>
</tr>
</tbody>
</table>

**Defining the breast implant situation**
- Select the **Implant type confirmation** checkbox if the type of implants is not known. Otherwise, you can deselect the checkbox.

Program steps for defining the implants will be added to the measurement queue. (Page A.4-5 *Defining the breast implant situation*)
| Measurements |

**Measuring silicone images**  
- Select the **additional silicone protocols** checkbox if you want to display silicone implants. ([Page A.4-13 Measuring pure silicone images (optional)])

**Accessing the Patient View**  
You can access the **Patient View** at any time during the examination.  
- To open the view, click the icon.  
- To confirm the settings and close the view, click the icon.

**Modifying parameters of measured protocols**  
Changes in the **Patient View** only apply to pending protocols in the measurement queue.  
- To change the status of a protocol from measured to pending, select the measured protocol.  
- Select **Rerun from here** from the context menu (right-click with the mouse)  
- Open the **Patient View**.  
- Select **Rerun from here with** from the context menu (right-click with the mouse).  
  The **Patient View** opens automatically.  
- Enter the requested modifications.
Starting the measurement of the localizer

◆ Confirm the patient-specific settings.

The sagittal, coronal and transverse localizers are measured and displayed.

If you have selected the **Implant type confirmation** checkbox, the **Implant type scan** starts automatically and the **Breast Implant Situation View** opens for defining the type and location of implants.

Defining the breast implant situation

The parameters for the subsequent measurements depend on the implant type. For normal breast MRI and saline implants, the fat signal needs to be suppressed (resonance frequency is centered over the water peak). For silicone implants, the water signal needs to be suppressed (resonance frequency is centered over the water peak). (➡ Page A.3-1 **Spectral differences**)
Confirming the resonance frequency

✓ Localizer has been measured
✓ Implant type scan has been started

At the beginning of the Implant type scan the Confirm Frequency Adjustment dialog window is displayed.

- Note the displayed frequency spectrum for the next step.
- Accept the frequency with Continue.
**Selecting the type and location of implants**

- Localizer has been measured
- Resonance frequency has been confirmed
- **Breast Implant Situation View** has opened
- Select the type of implants.

<table>
<thead>
<tr>
<th>None</th>
<th>The resonance frequency is centered over the water peak. <strong>Assume Dominant Fat</strong> is checked in the protocol.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Silicone</td>
<td>The resonance frequency is centered over the water peak. <strong>Assume Silicone</strong> is checked in the protocol.</td>
</tr>
<tr>
<td>Saline</td>
<td>The resonance frequency is centered over the water peak.</td>
</tr>
</tbody>
</table>

- Select the correct location of the implants (left, right, or both breasts).

Example: Two silicone implants
**Allocating the silicone peak**

Depending on the displayed frequency spectrum in the Confirm Frequency Adjustment dialog window you allocate the silicone peak.

- In the Breast Implant Situation View: Select the correct frequency spectrum.

<table>
<thead>
<tr>
<th>Silicone peak</th>
<th>The frequency adjustment settings of the protocols will be adapted automatically to Assume Silicone.</th>
</tr>
</thead>
<tbody>
<tr>
<td>No or small silicone peak</td>
<td>The frequency adjustment settings of the protocols will be adapted automatically to Assume Dominant Fat.</td>
</tr>
</tbody>
</table>

⚠️ If you have selected Bilateral Silicone the protocols are always adapted to Assume Silicone, independent from the setting in the spectrum.

After you have finished the definition of the breast implant type situation, a high-resolution 3D protocol opens.
Imaging the morphology

✔ Localizer images are displayed
✔ High-resolution 3D protocol has opened

Within this step, you can define the FoV and the slice position for all subsequent measurements.

In the GSP segments, the system makes a proposal for the FoV and the slice positioning.

- Check the FoV and the slice position in the GSP segments and adapt them, if necessary.
- If necessary, select the Parameters View to adapt additional settings for the measurements.
- Start the measurement.

The result images are displayed in the GSP.
3D Examinations with integrated MPR planning

The Breast Dot Engine provides an integrated planning step for MPR post-processing. MPRs of one or multiple 3D measurements are calculated immediately after each measurement. The MPR planning opens after the 3D measurements have been started. You are able to plan multiple MPR views with different orientations while the 3D measurements are running.

✓ 3D measurement has been started and the MPR planning step has opened

Example: Parameters View for sagittal MPR planning.
Select the desired MPR view from the list on the left side of the Parameters View.

The corresponding MPR slice positions and orientations are displayed in the GSP segments.

Adapt the slice positioning, if necessary.

In the Parameters View: You can also modify the view parameters alpha-numerically, e.g. the FoV.

Repeat the above steps for all MPR views.

Save the MPR settings.

As soon as the 3D measurements have been concluded, the reconstruction of the MPRs is started automatically. For each 3D measurement, the defined MPR views are generated.

The names of the resulting image series are a combination of the protocol name and the MPR view.

If you repeat a 3D measurement, a new set of MPRs is calculated.

You may use the resulting MPR views for the slice planning of subsequent measurements.
Subsequent measurements

After the initial measurements, the following measurements are performed:
- T1-weighted high-resolution measurement (delayed view)
- Diffusion-weighted measurement
- T2-weighted bilateral measurement

Measuring diffusion-weighted images

For a detailed description, please refer to: (➡ Page A.1-2 Measuring diffusion-weighted images)
- Auto Coverage checkbox has been selected
- Position the FoV and the saturation band very exactly.
Measuring pure silicone images (optional)

To display silicone implants during breast examinations, the signals from fat and water have to be suppressed. The result image displays the pure silicone signal.

As measurement technique, Turbo inversion recovery magnitude (TIRM) with water saturation is used. The fat signal is suppressed by an additional inversion pulse. The water saturation pulse (centered on the water peak) suppresses the signal from the breast and blood vessels. For a detailed description, please refer to: (➡ Page A.3-5 Displaying pure silicone images (optional))

- In the Patient View: Select the additional silicone protocols checkbox.

Three TIRM protocols with water saturation are added to the measurement queue.

- Start the measurement.

In the result image, silicone is displayed bright.
Displaying the biopsy coordinates

The biopsy coordinates that are calculated using the syngo Breast Biopsy software or the BreVis Biopsy task card can be displayed on the Dot display of the MR system. You can activate the display of the coordinates from within the biopsy measurement by using the Breast Step Dot add-in.![Page A.4-23 Configuring the biopsy support]

The coordinates are only valid until the next measurement is performed.

The available biopsy software depends on the connected coil. In the following, we are focusing on examinations with the 4-Channel BI Breast Coil and the syngo Breast Biopsy software.
Adapting the biopsy examination

◆ Select the biopsy support.

Select the biopsy software Breast Biopsy.

◆ Select the Left Breast or Right Breast.

◆ If you want to change the other settings, please follow the descriptions on the referenced page. (➡ Page A.4-2 Adapting the examination to the patient)

◆ Start the measurement.

The first morphologic measurement is performed. The Guidance View for biopsy planning opens.
Planning the biopsy

◆ Open the next protocol (control measurement).

◆ Plan the biopsy by selecting **Tools > Breast Biopsy** from the main menu.

◆ Perform the biopsy.

◆ Start the control measurement.

The calculated biopsy coordinates are displayed on the Dot display of the MR system.

As compared to **BreVis Biopsy**, the **syngo Breast Biopsy** software requires a pause between the completion of the biopsy planning and the transfer of the biopsy coordinates.
### Configuring program steps (optional)

**Dot Engine Step**

The **Dot Engine Step** defines which strategies, decisions (patient context decisions or clinical decisions) and global parameters are valid for the complete Dot Engine workflow examination. (For a detailed description, please refer to: [Operator Manual - System and data management].)

**Dot add-ins**

**Dot add-ins** are predefined add-ins for **Dot Engine Steps** and program steps. Depending on the selected **Dot add-in**, you can configure different parameters of the **Dot Engine Step**.
Assigning 3D measurements to the integrated MPR post-processing

Using the MPR Assignment Dot add-in you can define, for which 3D protocols the MPR post-processing is performed.

♦ In the Exam Explorer: Select a 3D protocol.
♦ Open the Protocol Properties dialog window (right-click with the mouse).
♦ Select the Dot add-in subtask card.
♦ Select the MPR Assignment add-in.

♦ Click Edit Configuration....
♦ Open the Dot Add-In Configurator by clicking Setup....
Select the **MPR Assignment** card.

Activate the MPR post-processing by clicking the corresponding checkbox.
Adding MPR views

Using the MPR Planning add-in, you can add new MPR views.

◆ In the Exam Explorer: Select the MPR planning program step.
◆ Open the protocol by double-clicking.
◆ Select the Dot add-in subtask card.
◆ Select the MPR Planning add-in.
◆ Click Edit Configuration....

◆ Open the Dot Add-In Configurator by clicking Setup....
Select the **MPR Planning** card.

Add the MPR view by clicking **Add MPR range**.

A new default MPR view is added to the list of available views.
Renaming views

- Right-click the added view with the mouse.

- From the context menu: Select **Rename**.
- Enter the new name.
- Set the **Guidance** and **Parameter Views**. (Operator Manual - System and data management)

Removing views

- Right-click the view with the mouse.
- From the context menu: Select **Remove**.
Configuring the biopsy support

◆ In the Exam Explorer: Select the control measurement.
◆ Open the protocol by double-clicking.
◆ Open the Dot Add-In Configurator by clicking Setup.
◆ Select the Breast Step card.

◆ Select the Breast biopsy type.
B.1 Spectroscopy evaluation

- Normalizing the choline signal
- Reviewing spectra
Post-processing
Spectroscopy evaluation

Normalizing the choline signal

✓ 1H MRS raw data is available
✓ Reference data set is available

Using normalization, the choline signal can be calibrated to a relative, standardized value. For this purpose, the ratio of the choline signal to the integral of the reference signal is computed. Normalized integral and amplitude values are displayed as $I^*$ and $A^*$, respectively.

◆ Select Applications > Spectroscopy.
The Spectroscopy task card opens.

◆ Select the raw data in the Patient Browser and load them to the Spectroscopy task card.
A post-processing protocol is applied automatically.
- Click this icon.

- Select the **Normalization to reference** post-processing step.

- Activate **Find and load automatically** to enable the automatic search for a reference data set.

- Start normalization with **Apply**.
**Reviewing spectra**

- Evaluate the images in the *Spectroscopy* task card.

Examples of spectra

Tumor spectrum of breast cancer before chemotherapy. Biopsy correlates with high choline signal in the spectrum.

Tumor spectra in the second cycle (left) and in the fourth cycle (right) of chemotherapy.
Post-processing
Index

A
ADC map A.1-1
   Evaluating A.1-4
ADC value A.1-2

B
Biopsy support
   Biopsy target coordinates A.4-14
Biopsy target coordinates
   Displaying A.4-14
Breast Dot Engine A.4-1
   Breast implant situation A.4-5
   Configuring program steps A.4-17
   Confirming the resonance frequency A.4-6
   Diffusion-weighted imaging A.4-12
   Imaging the morphology A.4-9
   Measuring the localizer A.4-5
   MPR planning A.4-10
   Patient View A.4-2
   Silicone images A.4-13
   Silicone peak A.4-8
   Subsequent measurements A.4-12
   Type and location of implants A.4-7
   Breast implant situation
      Breast Dot Engine A.4-5

C
Choline signal B.1-1

D
Diffusion-weighted imaging A.1-1
   ADC map A.1-1
   Determining the ADC value A.1-2
   Evaluating the ADC map A.1-4
   Performing the measurement A.1-2
   Principle A.1-1
   Setting parameters A.1-2
   Dot add-in
      Breast Step A.4-23
      MPR Assignment A.4-18
      MPR Planning A.4-20

DWI
   Refer to Diffusion-weighted imaging A.1-1

E
External reference
   Spectroscopy A.2-2, A.2-19

F
Fat signal
   Silicone implants A.3-6
Fat signals
   Spectroscopy A.2-8
Frequency
   Spectroscopy A.2-15

I
Imaging the morphology
   Breast Dot Engine A.4-9
Implant location
   Breast Dot Engine A.4-7
Implant type
   Breast Dot Engine A.4-7
Interactive shim
Spectroscopy A.2-11
Interference signals
Spectroscopy A.2-7
Internal reference
Spectroscopy A.2-2

L
Localizer
Breast Dot Engine A.4-5

M
MPR planning
Breast Dot Engine A.4-10

N
Normalizing B.1-1

P
Parameters
Diffusion-weighted imaging A.1-2
Patient View
Breast Dot Engine A.4-2
Program steps (Dot Engine)
Configuration A.4-17

Protocol adjustments
Spectroscopy A.2-9

R
Raw data
Spectroscopy A.2-17
Reference images
Spectroscopy A.2-3
Resonance frequency
Breast Dot Engine A.4-6
Silicone implants A.3-7, A.3-9
Respiratory artifacts
Spectroscopy A.2-7

S
Shim results
Spectroscopy A.2-14
Shimming
Interactively A.2-11
Silicone images A.3-5
Breast Dot Engine A.4-13
Silicone implants
Adjusting the resonance frequency A.3-7
Changing the resonance frequency A.3-9
General information A.3-1

Image examples A.3-3
Setting the water suppression A.3-10
Spectral differences A.3-1
Suppressing the fat signal A.3-6
Suppressing the water signal A.3-10
Silicone peak
Breast Dot Engine A.4-8
Spectra examples B.1-3
Spectral differences
Silicone implants A.3-1
Spectroscopy
Adjusting the frequency A.2-15
Applications A.2-1
General information A.2-1
Improving shim results A.2-14
Measuring raw data A.2-17
Measuring the external reference A.2-19
Planning the VOI A.2-4
Quantification A.2-2
Quantification with external reference A.2-2
Quantification with internal reference A.2-2

C-2
Quantifying total choline A.2-3
Reformatting reference images A.2-3
Setting weak water suppression A.2-7
Shimming interactively A.2-11
Starting protocol adjustments A.2-9
Suppressing fat signals A.2-8
Suppressing interference signals A.2-7
Suppressing respiratory artifacts A.2-7
Spectroscopy evaluation B.1-1
Examples of spectra B.1-3
Normalizing the choline signal B.1-1

T
Total choline
Quantifying A.2-3

V
VOI
Spectroscopy A.2-4

W
Water signal
Silicone implants A.3-10
Water suppression
Silicone implants A.3-10
Spectroscopy A.2-7